
OPERATING GUIDE FOR 

Photovoltaic Power 

Profile Emulation Software 

Via Acquanera, 29   22100  Como
tel.  031.526.566 (r.a.) fax  031.507.984
info@calpower.it   www.calpower.it



ii | Magna-Power Electronics, Inc.   Photovoltaic Power Profile Emulator Software  

  

 

 

 

 

 

 

 

 

[This page is intentionally left blank]  



www.magna-power.com  Magna-Power Electronics, Inc. | iii 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MAGNA-POWER ELECTRONICS, INC. 

39 ROYAL ROAD, FLEMINGTON, NJ  08822 

November 26, 2011 

  



iv | Magna-Power Electronics, Inc.   Photovoltaic Power Profile Emulator Software  

 

 

 

 

 

 

 

 

 

[This page is intentionally left blank] 

  



www.magna-power.com  Magna-Power Electronics, Inc. | v 

TABLE OF CONTENTS 

Section Title              Page 

1.0 GENERAL INFORMATION .......................................................................................................... 1 

1.1 Features ........................................................................................................................................ 1 

1.2 Requirements ................................................................................................................................ 1 

2.0 QUICK START ............................................................................................................................... 2 

3.0 INSTALLATION ............................................................................................................................ 3 

4.0 USING THE PHOTOVOLTAIC POWER PROFILE EMULATION ............................................ 6 

4.1 Power Supply Status and Control ................................................................................................ 7 

4.2 Reference Parameters ................................................................................................................... 8 

4.3 Profiles ....................................................................................................................................... 10 

4.3.1 Manual Activation .............................................................................................................. 11 

4.3.2 Sequential Activation .......................................................................................................... 12 

4.3.3 Profile Interpolation ............................................................................................................ 12 

4.4 Profile Parameters and Generation ............................................................................................. 13 

4.4.1 Profile Generation Using Based on Reference Method ...................................................... 14 

4.4.2 Profile Generation Using 4-Parameter Method .................................................................. 14 

4.4.3 Profile Generation Using Manual Method .......................................................................... 15 

4.5 Profile Import and Export .......................................................................................................... 15 

4.5.1 Profile Import ...................................................................................................................... 15 

4.5.2 Profile Export ...................................................................................................................... 16 

4.6 Power Profile Graph ................................................................................................................... 16 

4.7 Sessions ...................................................................................................................................... 18 

4.8 Viewer ........................................................................................................................................ 19 

4.9 Options Menu ............................................................................................................................. 20 



vi | Magna-Power Electronics, Inc.   Photovoltaic Power Profile Emulator Software  

4.9.1 Graph Options ..................................................................................................................... 21 

4.9.2 Control Options ................................................................................................................... 21 

4.9.3 New Session Reference Parameters .................................................................................... 22 

4.9.4 Data Logging ...................................................................................................................... 22 

5.0 LICENSING .................................................................................................................................. 24 

5.1 Overview .................................................................................................................................... 24 

5.2 License Manager ........................................................................................................................ 24 

6.0 COMMUNICATION ..................................................................................................................... 25 

6.1 RS-232 (Serial) Setup................................................................................................................. 25 

6.2 LXI TCP/IP Ethernet Setup........................................................................................................ 25 

6.3 IEEE 488.2 GPIB Setup ............................................................................................................. 27 

6.4 Communication Problems .......................................................................................................... 28 



www.magna-power.com  Magna-Power Electronics, Inc. | 1 

1.0 GENERAL INFORMATION 

1.1 Features 

Magna-Power Electronics power supplies with D version front panel or any XR Series model offer an 

analog input to modulate the voltage or current setting using piecewise linear approximation. This 

feature enables the voltage or current setting to be adjusted by a sensor input, such as a thermistor, or by 

monitoring its own voltage or current.  Modulation allows the output to be tailored for advanced process 

control applications, battery charging, and source emulation. 

Photovoltaic Power Profile Emulator is a Microsoft Windows® based utility to enable Magna-Power 

Electronics’ power supplies to emulate photovoltaic arrays. The software utilizes solar panel technology 

characteristics and creates a 50 point piecewise linear approximation table for use with the powerful 

modulation feature in the power supply. Implementation allows the user to program a soft knee as a 

function of both output voltage and current.    

1.2 Requirements 

This software is only available for use on Magna-Power Electronics DC power supplies that support 

modulation. This includes any power supply with the D version front panel option or any XR Series 

model. The D Panel power supply must have firmware revision 4.7 or higher. XR Series models require 

a firmware revision of 1.4 or higher for full functionality. 

This software requires a computer running Windows XP or higher with a screen resolution of 1024x768 

or higher. The Microsoft .NET Framework 2.0 or higher is also required.  You will be prompted to 

install the .NET Framework if you do not already have it installed. 

The computer must be able to establish communication with the power supply.  You may use the power 

supply’s RS-232 (Serial) port, optional LXI TCP/IP Ethernet, or option IEEE 488.2 GPIB. 
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2.0 QUICK START 

The following instructions will help you get started using the software with a single profile immediately.  

See the related sections in the manual for additional information. 

1. The software and hardware requirements for this Quick Start are: 

a. A Magna-Power Electronics DC power supply with modulation support (D version front 

panel or XR Series). 

b. A personal computer running Windows XP or higher. 

c. Communication established between the computer and power supply through either RS‒

232, GPIB, or TCP/IP. 

d. A PPPE software license for each power supply to be used. 

2. Power supply setup: 

a. Jumper pins 5 and 25 on the connector JS1 illustrated in Figure 1.1 of the power supply 

manual. 

b. Turn the power supply on but leave it in STANDBY mode. 

c. Connect the desired load to the power supply’s output terminals. 

3. Install and launch the software: 

a. Install the software using the provided CD or download. Follow the onscreen 

instructions. (Note: If downloading the software from the website, Microsoft Visual 

Studio .NET v3.5 or high is required). 

b. Launch the software from the Start Menu or the icon placed on the Desktop. 

4. Establish communication 

a. Select Setup Communication… from the Tools menu. 

b. Enter the appropriate communication configuration information.  If utilizing IEEE 448.2 

GPIB or LXI TCP/IP Ethernet, use the Find Devices button to help locate the power 

supply automatically. 

c. Select OK. 

d. Verify that the power supply was identified and the model number was populated in the 

upper left portion of the software. 

5. Select your desired solar panel technology and enter the remaining array specifications in the 

Reference Parameters box. 

The software will verify the parameters are within the connected power supply’s capabilities and 

will display warning or error icons next to invalid or out of range parameters. 

6. Select the New button under the Profiles grid to create a new profile based on the reference 

parameters 

7. Modify the profile’s name, temperature, and irradiance in the Profile Parameters box. 

Observe the automatically generated curve about these parameters.  

8. Select the Activate to send the calculated points to the power supply. 

9. Select the green START button to enable the power supply’s output. 
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3.0 INSTALLATION 

After inserting the Magna-Power Electronics’ CD into the drive, a user is given a choice to install the 

RIS Panel or the Photovoltaic Power Profile Emulation software. Select the Photovoltaic Power Profile 

Emulation Software to view the Installation dialog box, Figure 3.1.  Select Next to continue. 

 

Figure 3.1 Initial installation dialog 

The following dialog box, Figure 3.2, allows selection of the installation directory.  Confirm the 

installation directory, Figure 3.3, and press Next. By default, the software will be installed in “Program 

Files\Photovoltaic Power Profile Emulation\.” To install the software to a different location, select 

Browse and then select your desired folder. When the install folder is correct, select Next to continue 

installation. 
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Figure 3.2 Installation path dialog 

. 

 

Figure 3.3 Installation confirmation dialog 
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Upon installation completion, the dialog box shown in Figure 3.4will appear.  

 

Figure 3.4 Installation complete dialog 
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4.0 USING THE PHOTOVOLTAIC POWER PROFILE EMULATION 

 Figure 4.1shows the main screen of Photovoltaic Power Profile Emulation Software. The software is 

divided into the following areas: 

1. Power supply status and control (Section 4.1) 

2. Reference Parameters (Section 4.2) 

3. Profiles (Section 4.3) 

4. Profile Parameters (Section 4.4) 

5. Power Profile Data Points (Section 4.4.3) 

6. Power Profile Graph (Section 4.6) 

7. Viewer Tab (Section 4.8) 

 

Figure 4.1 Screenshot of Photovoltaic Power Profile Emulation Software’s Programming Tab 
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Figure 4.2 Screenshot of Photovoltaic Profile Emulation Software's Viewer Tab 

4.1 Power Supply Status and Control 

The software’s Power Supply area, shown in Figure 4.3, identifies the power supply’s model, status, 

measured voltage and measured current, and any alarms. This area also shows the active profile and the 

remaining number of seconds before the next profile is activated. 

 

Figure 4.3 Power supply status and control 
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The START and STOP buttons turns the power supply’s output on and off, respectively.  These are 

equivalent to pushing the physical START and STOP buttons on the power supply. The Clear Alarms 

button clears power supply alarms, such as Over Voltage Trip (OVT) or Over Current Trip (OCT).  

Alarms must be cleared before the power supply’s output can be reenergized. 

The Power Supply area is not active unless the software has established communication with a power 

supply. A valid license is required for each power supply serial number as described in Section 5.0. 

Figure 4.4 shows the status bar at the bottom of the main screen.  It provides the current communication 

protocol and setup, such as COM port or IP address. 

 

Figure 4.4 Communication protocol status bar 

4.2 Reference Parameters 

The software’s Reference Parameters area, Figure 4.5, allows the user to enter the solar panel’s 

reference parameters. Nominal parameters are typically supplied by the manufacturer of a photovoltaic 

array, namely: 

     photovoltaic array’s open circuit voltage [V] 

     photovoltaic array’s short circuit current [A] 

     photovoltaic array’s voltage at maximum power point [V] 

     photovoltaic array’s current at maximum power point [A] 

   photovoltaic array temperature [°C] 

      nominal photovoltaic array temperature [°C] 

    photovoltaic array irradiance PV generator temperature [W/m
2
] 

       nominal photovoltaic array irradiance PV generator temperature [W/m
2
] 

α  temperature coefficient for current 

β  temperature coefficient for voltage 
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Figure 4.5 Photovoltaic array reference parameters 

Reference parameters may be changed at any time.  Automatically calculated profiles will display new 

parameters, a new power profile on the grid, and will update the graph immediately, but they will not be 

sent to the power supply until the next time the profile is activated.  

If the software detects any invalid parameters, as illustrated in Figure 4.6, it will display an icon next to 

the corresponding parameter label. The specification error can be displayed by holding the mouse cursor 

over the icon to display the error. 

 

Figure 4.6 Reference parameters with invalid values 
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The EN50530 standard provides technology-dependent constants for the leading solar panel 

technologies: cSi and thin film (Table 4.1). Selecting one of these technologies from the Reference 

Parameter’s Tech dropdown menu auto-fills these constants, as shown in Figure 4.7. (Note: At nominal 

values there is a slight offset from the reference parameters. This offset can be attributed to an offset 

from the EN50530 model and is considered very marginal).  

 

Figure 4.7 Reference parameters dropdown menu for technology dependent constants 

Table 4.1 Technology dependent constants from EN50530 standard 

 cSi technology Thin film technology 

    [ ] 0.8 0.72 

    [ ] 0.9 0.8 

   [W/m
2
] 2.514E-03 1.252E-03 

   [ ] 8.593E-02 8.419E-02 

   [m
2
/W] 1.088E-04 1.476E-04 

     [ ] 0.95 0.98 

α [%/C] 0.04 0.02 

β [%/C] -0.4 -0.2 

4.3 Profiles 

A profile is a current versus voltage curve that the power supply’s output should emulate. There are two  

options for generating profiles with the Photovoltaic Power Profile Emulation software; they are: 

1. Automatic, based on solar array reference parameters: Reference Parameters are defined in 

accordance with desired array. For each new profile, only temperature and irradiance values 

need to be defined. As further described in Section 4.4.1, remaining parameters are calculated 

automatically: maximum power point (Vmp, Imp), open circuit voltage (Voc), and short circuit 

current (Isc) in accordance with the EN50530 model. This procedure is described in Section 

4.4.1.  

2. Automatic, based on 4-parameters: The user defines the maximum power point (Vmp, Imp), 

open-circuit voltage (Voc), and short-circuit current (ISC). The profile is then generated based on 

these parameters. The procedure is described in Section 4.4.2. 

3. Manual: The profile is defined with 50 current and voltage points using picewise linear 

approximation. The procedure is described in Section 4.4.3. 

To create a new profile, select the New button. By default, a new profile is created based on the nominal 

reference parameters. To change the default profile generation, refer to Section 4.4.  
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The selected profile is displayed in the Profile Parameters area, the data table, and the power profile 

graph. The selected profile is highlighted in a power profile graph with its data points as dots.  

To delete a profile, select the profile you wish to delete from the Profile dialog box, Figure 4.8, and then 

select the Delete button. A confirmation dialog box, shown in Figure 4.9, will appear. To hide a profile 

from the graph below, uncheck the Show On Graph checkbox from the profile you wish to hide. The 

selected profile is always shown on the graph. 

 

Figure 4.8 Photovoltaic profiles 

 

Figure 4.9 Delete profile dialog 

4.3.1 Manual Activation 

To activate the selected profile, select the Activate button.  The selected profile is sent to the power 

supply.  During activation, a progress bar is displayed in the lower right corner of the status bar.  Once 

activated, the profile is highlighted with green and is displayed in the Power Supply box above and the 

status bar at the bottom. 
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4.3.2 Sequential Activation 

Profiles can be activated in sequence, one after another, automatically by the software.  The order of 

activation is determined by the order the profiles listed in the Profiles grid.  To rearrange the profiles up 

or down in sequence, select a profile and select on the up or down arrows next to the grid. 

To loop the sequence, check the Loop checkbox.  If this box is checked, the sequence will return back to 

the top of the profiles after the end of the sequence.  If this box is not checked, the automatic sequence 

ends with the last profile. 

To start sequential activation, select the green Play button.  The sequence starts with the current active 

profile.  If no profile is active, the first profile in the list is activated. 

To pause, select the Pause button.  The time remaining is stopped.  Select the Play button to resume the 

sequence.   

Select the >| button to skip to the next profile.  Select the |< button to skip to the previous profile.  

A different profile can be skipped at any time by selecting that profile and clicking the Activate button.  

After activation, the automatic sequence will continue from the newly activated profile. 

4.3.3 Profile Interpolation 

Profile interpolation allows automatic generation of intermediary profiles between two defined curves 

over a defined time period. To use this function, define two curves, the starting curve and the finishing 

curve, and place the curves in sequential order in the profile listing. Define the time period for the 

transition in the starting curve, then select the Interpolate button. The dialog will pop up, as shown in 

Figure 4.10, allowing the number of intermediary profiles to be selected. The number of seconds per 

profile will be evenly distributed for all the interpolated profiles, increasing or decreasing depending on 

the number of profiles to be generated.   

 

Figure 4.10 Interpolate profiles dialog 
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4.4 Profile Parameters and Generation 

As shown if Figure 4.11, the selected profile’s parameters can be adjusted in the Profile Parameters area. 

The parameters in this section are as follows: 

Name: The profile’s name, to distinguish a specific voltage-current curve from other profiles  

Color: The color of the profile in the graph. 

Show on Graph: To hide a profile from the graph below, uncheck the Show On Graph checkbox 

from the profile you wish to hide.  The selected profile will always be shown on the graph. 

Include in Sequence: If checked, the selected profile will be included in sequence of profiles. 

The next profile will be automatically loaded when the selected profile’s time expires. If clear, 

the selected profile will be skipped during sequential operation. 

Time: Duration the selected profile is active during sequential operation. 

Based on Reference: Profile generation using the solar array reference parameters and the 

EN50530 model. (See Section 4.4.1) 

T: Photovoltaic array temperature [°C]; used only the Based of Reference profile 

generation method. 

Ir: Photovoltaic array irradiance PV generator temperature [W/m
2
]; used only the Based 

of Reference profile generation method.  

4-Parameter: Profile generation through definition of maximum power point, open-circuit 

voltage and short-circuit current. (See Section 4.4.2) 

Vmp: Voltage at the maximum power point [V]; used only the 4-Parameter profile 

generation method. 

Imp: Current at the maximum power point [I]; used only the 4-Parameter profile 

generation method. 

Voc: Voltage at open-circuit [V]; used only the 4-Parameter profile generation method. 

Isc: Current at short-circuit [I]; used only the 4-Parameter profile generation method. 

Manual: Profile generation through definition of 50 operating or data import. (See Section 4.4.3) 
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Figure 4.11 Profile parameters 

4.4.1 Profile Generation Using Based on Reference Method 

When the Based on Reference radial button is selected, the profile will be automatically calculated 

from the reference parameters, temperature, and irradiance values in accordance with the EN50530 

model. Changes to the profile’s temperature, irradiance will modify the selected curve. Changes to any 

of the reference parameters will automatically recalculate all 50 points in the curve.   

To create a new profile, select the New button. By default, a new profile is created based on the nominal 

reference parameters. To change the default profile generation, refer to Section 4.4. The profile will vary 

from nominal values by altering the temperature (T) or irradiance (Ir) value for that profile. 

Profile generation using the Based on Reference method will cause new data points in the table and on 

the graph to appear immediately, but they will not be sent to the power supply until the next time the 

profile is activated. Press the Activate button to have the newly calculated profile sent to the power 

supply. If the power supply output is energized when the new profile is activated, the power supply will 

update its output immediately. 

4.4.2 Profile Generation Using 4-Parameter Method 

When the 4-Parameter radial button is selected, profiles will be automatically calculated based on Voc, 

Isc, Vmp, and Imp. This method of profile generation assumes nominal values for temperature and 
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irradiance to generate profiles in accordance with EN50530. Changes to any of the 4-Parameter values 

will modify the selected curve.  

To create a new profile, select the New button, then choose the 4-Parameter radial button. The values 

prepopulated in the parameter fields are retained from the Based on Reference profile generation 

method.  

When generating curves using the 4-Parameter method, Vmp and Imp should always be less than Voc and 

Isc, respectively. Depending on the technology and furthermore, the fill factor, the ratio of Vmp:Voc (FFV) 

and Imp:Isc (FFI) will vary. Reference Table 4.1 for fill factor values for various solar panel technologies.  

Profile generation using the 4-Parameter method will cause new data points in the table and on the 

graph to appear immediately, but they will not be sent to the power supply until the next time the profile 

is activated. Press the Activate button to have the newly calculated profile sent to the power supply. If 

the power supply output is energized when the new profile is activated, the power supply will update its 

output immediately. 

4.4.3 Profile Generation Using Manual Method 

When Automatic V/I checkbox is cleared, the software will be in a manual profile generation mode. 

Reference parameters are not required for this method of profile generation.  

In manual profile generation, the data table becomes active, allowing all the values to be modified. Up to 

50 voltage and current values may be entered.  The New, Delete, and Clear buttons below the table 

allow manual control over the points.  To edit a point for voltage or current, select in the appropriate cell 

and make the revision. The point being edited is highlighted with a light gray circle on the graph. 

Requirements for the manual voltage/current data table entry are: 

1. The first row must have a voltage value of 0 Vdc.  

2. The last row must have a current value of 0 Adc. 

3. The normalized slope (∆I/∆V)×(Imax /Vmax) cannot be greater than -0.05. 

Profile generation using the Manual method will cause new data points in the table and on the graph to 

appear immediately, but they will not be sent to the power supply until the next time the profile is 

activated. Press the Activate button to have the new profile sent to the power supply. If the power 

supply output is energized when the new profile is activated, the power supply will update its output 

immediately. 

4.5 Profile Import and Export 

4.5.1 Profile Import 

When the Manual profile generation method selected, profiles can be imported from a comma-separated 

value (.csv) file. With the Manual radial button selected, select Import under the 50-point table. Then, 
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from the drop-down menu in the import window, select Comma separated value (.csv). Guidelines for 

the .csv file to be imported are as follows: 

 The first column must be voltage and the second column must be current. 

 Any columns beyond the first two columns are ignored. 

 The .csv file may have text headers on the first row. The software will parse the first row and if 

text, will begin the import on the second row, and if numeric, will begin the import on the first 

row. 

 Single and double quoted values are supported, for example: "40.000" and '60.000' 

 The values are trimmed of whitespace and quotes before being parsed.   

The import will handle values where a comma is used as a decimal point as reflected by the regional 

settings, for example: "40,000" and '60,000'.  Otherwise a comma is treated as a thousand separator. 

4.5.2 Profile Export 

Profiles may be exported regardless of the profile generation method. Export requires an active 

connection to a licensed Magna-Power Electronics power supply. There are three export formats, 

selectable from the drop-down export window. The export formats are as follows: 

 Photovoltaic Power Profile Emulation Export (.pppeExport): A proprietary photovoltaic 

power profile format that can only be read by Magna-Power Electronics Photovoltaic Power 

Profile Emulation software, compatible with legacy version of the software. 

 SCPI Commands (.txt): The SCPI commands issued by the PPPE software to the power supply 

to define the profile for emulation. Each SCPI Command export is approximately 55 commands. 

The PPPE software can be used to generate complex photovoltaic profiles, while SCPI command 

export enables these complex profiles to be transferred to other software environments, such as 

LabVIEW or Visual Studio. Commands will vary whether Voltage Control or Current Control 

is selected in the Options menu; make sure to note the proper jumper setting from this control 

configuration. 

 Comma-delimited (.csv): Data export of the generated 50-point curve in a widely accessible 

format.  

4.6 Power Profile Graph 

The graph displays calculated power profiles, maximum power point, power supply output, and 

information about a selected data point.  The selected profile is displayed with its data points as dots.  

Hovering over one of these dots highlights the corresponding point on the V/I table.  The scale of the 

graph is automatically calculated based on what is being displayed. 

Additionally, the power supply’s measured output is displayed as a green circle. The measured power 

supply output is updated continuously on the graph while communicating with the power supply.  The 

power supply output is not displayed if communication is not established or it is disrupted. 
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The selected profile’s maximum power point is displayed at the X on the curve.  The maximum power 

point is not displayed for manually entered power profiles. 

The bottom right corner of the graph displays the tracking efficiency,   . This percentage is calculated 

as follows:  

   
                        

                           
       

The power profile graph can be displayed as either current versus voltage or as a power versus voltage 

curve as illustrated in Figure 4.12 and Figure 4.13, respectively. The procedure for selection of graphical 

representation is described in Section 4.8. 

 

Figure 4.12 Current vs. voltage graphical display 
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Figure 4.13 Power vs. voltage graphical display 

4.7 Sessions 

A session is a set of reference parameters of one or more profiles based off those parameters.  Sessions 

can be saved and loaded as .pppe files.  When the software is first launched, a blank session is created. 

If you attempt to create new session, open a different session, or exit the program and the current session 

has changed, the software will prompt you to save the current session first. 

As illustrated in Figure 4.14, select Yes to save the current session, or select No to discard the changes 

to the current session.  Select Cancel to return to the current session. 

 

Figure 4.14 Save current session dialog 

To save a session, select Save Session from the File menu or use the keyboard and type Ctrl+S.  If the 

file has not been saved previously, the software will prompt for a filename.  To save a session to a 

different file, select the Save As item from the File menu.  Browse the folders on the computer where to 

save the session, type the file name, and then select the Save button. 
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To open a session, select the Open Session item from the File menu or use the keyboard and type 

Ctrl+O.  Browse to the folder on the computer that contains the session (.pppe file) to be opened.  Select 

the file and select the Open button. 

To create a new session, select the New Session item from the File menu or use the keyboard and type 

Ctrl+N. 

To exit the software, select the Exit item from the File menu or use the keyboard and type Alt-F4.  

Alternatively, select the X in the upper right corner of the application to exit the software. 

4.8 Viewer 

The Viewer tab (Figure 4.15) provides a graphical view of both the voltage/current profiles as well as 

key parameters as a function of time. In clockwise order, starting with the largest graph in the top left, 

the graphical outputs are: 

 Current (Adc) versus voltage (Vdc) profile(s) programmed by the user for the power supply to 

emulate, identical to the graph on the Programming tab. 

 Power (kW) versus voltage (Vdc) profile(s) programmed by the user for the power supply to 

emulate.  

 Power (kW) versus current (Adc) profile(s) programmed by the user for the power supply to 

emulate. 

 Power (kW) versus time (min) continually updated at the interval specified in the Options menu. 

 Current (Adc) versus time (min) continually updated at the interval specified in the Options 

menu. 

 Voltage (Vdc) versus time (min) continually updated at the interval specified in the Options 

menu. 
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Figure 4.15 Viewer tab panel 

4.9 Options Menu 

To enter the options menu, select Options from the Tools menu. The options menu is illustrated in 

Figure 4.16. 

As described in Section 4.6, there are two options to format the graph: Voltage versus Current or 

Voltage versus Power.  
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Figure 4.16 Options menu 

4.9.1 Graph Options 

The primary graph may be displayed as either current versus voltage (default, Figure 4.12) or power 

versus voltage (Figure 4.13). Select the radial button next to the desired graphical display and hit 

confirm the selection by pressing OK to update the display. 

The Interval parameter is the graphical x-axis time parameter’s display interval, used in the Viewer tab. 

This interval parameter is the time period in which each time-dependent graph in the Viewer tab is 

updated.  

4.9.2 Control Options 

The power supply is capable of either modulating voltage as a function of current (current control, 

default) or current as a function of voltage (voltage control). A jumper of the power supply’s rear JS1 

connector (Figure 4.17) provides the necessary analog feedback loop necessary for the high-speed 

computation. Current Control requires creating a jumper or short between pins 5 (VO2) and 25 

(VMOD). Voltage Control requires creating a jumper or short between pins 24 (IO2) and 25 (VMOD) 

on the JS1 connector.  

Both methods of control are available to accommodate various load control methodologies. For voltage-

mode controlled loads, setting the power supply to Current Control (JS1 5-25) is recommended. For 
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current-mode controlled loads, setting the power supply to Voltage Control (JS1 24-25) is 

recommended.  

 

Figure 4.17 JS1 37-Pin External Programming  Connector 

The Slew Limit factor allows the power supply’s modulation performance to be adjusted to account for 

various load requirements. This command controls the allowable slew rate as a function voltage/current 

profile. The factor ranges between 0.0 and 1.0, where 0.0 has the highest stability/lowest slew rate and 

1.0 has the lowest stability/highest slew rate. For loads demanding high bandwidth, the slew limit should 

be increased until an adequate performance level is reached.   

4.9.3 New Session Reference Parameters 

The New Session Reference Parameters section features parameters identical to the photovoltaic array 

reference parameters in the main software, previously illustrated in Figure 4.5. Configuring the New 

Session Reference Parameters in the options menu enables default photovoltaic array reference 

parameters to be specified. These parameters can be manually entered or they can be automatically 

entered using the Use Current Parameters button. Whenever a new session is created, the reference 

parameters will be automatically populated with the defined New Session Reference Parameters. If no 

parameters are specified, the default reference parameters will be blank. 

4.9.4 Data Logging 

Data logging is available to store both profile and measured data to a comma separated value (.csv) file 

as a function of time. This data can later be used for external report generation or analysis.  

By default, data logging is disabled. To enable data logging, select the checkbox labeled Enable data 

logging. Unselect this checkbox to disable data logging. The following functions will be enabled when 

data logging is enabled. 

The Filename field is the location on your computer or network where the data should be saved. Data 

will start logging and stop logging in accordance with the power supply’s start and stop functionality.  
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The If exists radial button determines how data logging will resume if the file already exists. If 

Overwrite is selected and the target file already exists, all existing log data will be lost each time the 

power supply starts. If Append is selected and the target file already exists, all existing log data will be 

maintained and new data will be logged at the end of target file. If Create unique name is selected and 

the target file already exists,  all existing log data will be maintained and a new file will be created with 

a unique “-#” suffix, iterating to another number each time the power supply output is enabled.  
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5.0 LICENSING 

5.1 Overview 

A license is required to connect to a power supply. One license is required for each power supply. A 

single PPPE installation can connect to several licensed power supplies. License files are provided on a 

CD when the power supply is shipped. The license automatically configures on installation. Section 5.2 

describes the configuration for additional power supply licenses.  

If you have misplaced your original CD, please contact Magna-Power Electronics at support@magna-

power.com or call (908) 237-2200 to retrieve your license file.  

5.2 License Manager 

As shown in Figure 5.1, PPPE Software features a built-in license manager to manage licenses for 

several power supplies. The license manager is available by selecting Help from the main toolbar and 

then selecting License Manager.  

 

Figure 5.1 License Manager for PPPE 

To add a license file, select Add and then browse for your .lic file that was provided by Magna-Power 

Electronics. To remove a license file, select a license from the license manager then select Remove.  

  

mailto:support@magna-power.com
mailto:support@magna-power.com
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6.0 COMMUNICATION 

The software can communicate with a power supply via any of the following: 

 RS-232 (Serial) 

 LXI TCP/IP Ethernet 

 IEEE 488.2 GPIB 

Sessions and profiles can be setup without connecting to a power supply, but activating the profiles, 

power supply, status, and control are not possible unless communication is established. 

The software will save the communication settings when exiting the program.  The next time the 

software is launched, it will attempt to reestablish communication with the power supply using the 

previous settings. 

To establish communication, select Setup Communication item from the Tools menu. When 

communication is established, the Power Supply dialog box in the upper left will display information 

about the power supply’s current state.  In addition, the status bar at the bottom will show the 

communication method and information.   

6.1 RS-232 (Serial) Setup 

To connect to the power supply with a serial (comm) port, select RS-232 from the Type of 

Communications dropdown as illustrated in Figure 6.1.  The software populates the detected serial 

(comm) ports in the Comm Ports dropdown.  Select the port used by the power supply to and then 

select the OK button. 

 

Figure 6.1 RS-232 communication setup 

6.2 LXI TCP/IP Ethernet Setup 

To connect to the power supply via TCP/IP (Ethernet), select TCP/IP from the Type of 

Communications dropdown as illustrated in Figure 6.2.  Enter the power supply’s hostname or IP 
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address in the Address textbox and enter the appropriate port (typically 50505) in the Port textbox.  

Then select OK. 

 

Figure 6.2 TCP/IP communication setup 

Alternatively, devices can be located on the network automatically with the Find Device button.  As 

shown in Figure 6.3, select the power supply from the list and then select OK.  Select the Refresh 

button to rescan the network for power supplies or select Cancel to return to the previous screen without 

selecting a power supply. 

 

 

Figure 6.3 TCP/IP Find Devices dialog 
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6.3 IEEE 488.2 GPIB Setup 

To connect to the power supply via GPIB (IEEE 488.2), select GPIB from the Type of 

Communications dropdown as illustrated in Figure 6.4.  Select the power supply’s GPIB Address from 

the dropdown and then select OK. 

Figure 6.4 GPIB communication setup 

Alternatively, the Find Device button can be used to try to locate the device on the GPIB bus 

automatically, as illustrated in Figure 6.5.   

Figure 6.5 GPIB Find Devices dialog 

The software will scan the GPIB bus and will display the devices found along with their responses to the 

*IDN? query.  Select the power supply from the list and then select OK.  Select the Refresh button to

rescan the bus or Cancel to return to the previous screen without selecting a power supply.
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6.4 Communication Problems 

If communication cannot be established or there is a disruption in communication with the power 

supply, an error will be displayed as illustrated in Figure 6.6. Select the Show Details button to display 

internal information about the error.  Use the Copy to Clipboard button to copy the detailed information 

to the clipboard.  This information may be useful to troubleshoot the error. 

(a) 

 (b) 

Figure 6.6 (a) Communication error dialog  (b) Details of communication error 
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